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WELCOME!

Welcome to Multi-Ad Creator® 4.0!

For years, Creator has been the program of choice for creating advertising
layouts on Macintosh® computers. No other program comes close: Creator is
faster, easier, more intuitive, and has more features that are designed
specifically for producing advertisements.

With the release of version 4.0, Creator takes you and your Macintosh to
new levels of quality, speed, and productivity. We’ve added features to let
you work faster, features to help you print, features for creating and
modifying graphics, and much more.

At its core, Creator is a Macintosh application. If this is your first time using
a Macintosh, then you’ll find Creator and the Macintosh to be simple,
powerful, and, best of all, intuitive. If you know how to use a Macintosh,
then you’ve already got a head start on using Creator. It uses almost all of
your favorite keyboard shortcuts—Cmd-P for Print, Cmd-Shift-B for
boldface type, and so on.

If you are new to Macintosh computers or desktop publishing programs in
particular, we suggest you read this User’s Guide before venturing too far
into Creator. It’s been written to help you get started producing ad layouts
quickly. Think of it as a self-paced training course.

For more introductions, you may want to try the Getting Started Guide. It
contains some helpful exercises that illustrate some key Creator features, as
well as a list of version 4.0’s new features. If you need help or information
about a specific feature, you can turn to the Creator Reference Manual. It
gives you in-depth descriptions of each individual Creator feature, allowing
you to get only the help you need, when you need it.

Whatever your background, Creator provides you with the most powerful
collection of tools and features available, without sacrificing any ease of use.
We hope you enjoy using Creator!
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THE MULTI-AD CREATOR SCREEN

To use Creator, it’s important to understand each element on the screen. The
first half of this guide concerns itself with screen elements. The second half
focuses on using graphics, text, Preferences, and multiple layouts.

The Ad Sizes
Dialog Box

The Ad Sizes dialog box is the first item you see after opening an ad.

It’s used to set the dimensions (width and depth) for the ad you’re
designing. This dialog box gives you several options. You can determine ad
size by either entering the ad’s width and depth or by choosing from
Creator’s mini-database of preset ad sizes. The preset choices include:

• SAU (Standard Advertising Unit) Sizes.
SAU sizing is an established system of ad sizing used by
newspapers. An SAU column is 2 1/16 inches wide, so a
1 x 3 SAU ad is 2 1/16 inches wide and 3 inches deep.
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• TMAU (Television Magazine Advertising Unit) Sizes.
TMAU Sizes is a database of ad sizes designed for creating a
standard for advertisers in television listing magazines.

• Other Sizes.
These are commonly used sizes, like letters and business cards, for
example.

For more flexibility, you can create your own mini-database of sizes by
adding, changing, or deleting ad sizes.

To add an ad size
Enter a new name (for example, “My Ad Sizes”) in the text field below the
Publication list. Below the Size list, enter the ad name (for example,
“Brown’s Grocery”). Enter the desired width and depth and click Add.
Click OK.

To change an ad size
Scroll through the list of sizes and select the ad size you want to change.
Change the width and depth to the desired dimensions and click Change.
Click OK.

To delete an ad size
Scroll through and select the ad size you want to delete. Click Delete.
Click OK.

Tip: To avoid the Ad Sizes dialog box when opening an ad, hold down the
Shift key while selecting New from the File menu. The ad size will be
the same as the last ad designed.

Tip: You can bring up the Ad Sizes dialog box by double-clicking on the Ad
Resize Handle in the Ad Window.
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The Ad Window
After you’ve set the ad size, the Ad Sizes dialog box disappears, and you are
presented with the Ad Window where the ad is displayed. Though similar
to a standard Macintosh window, the Creator Ad Window includes several
additional features.

Close box Title bar Zoom box

Rulers

Scroll bars Size boxStatus area 
resize bar

Status areaStatus labels

Guide Snap 
toggle

Tools 
palette

Commands palette

Ad Area

Ad border

Ad resize handle

Desk area

Colors 
palette

Files 
palette

Styles 
palette

The Ad Area
The rectangle in the center of the window is the Ad Area. (The dimensions
are determined in the Ad Sizes dialog box.) When you print the ad,
everything you see in the Ad Area is printed. If, for example, you print
before doing any work on the ad, you would print a rectangle with a 1-
point-wide rule, representing the ad. Normally, Creator prints only the
objects that lie within the Ad Area. For information on printing objects
outside the Ad Area, refer to the Page Setup section in the Creator Reference
Manual.
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Every Ad window contains only one rectangle representing the ad. If you
wish, you can change the ad dimensions or the attributes of the ad border
(thickness, design, etc.), or even set the ad border to None. However, a
conceptual border always exists in the Ad Window to remind you of the
ad’s dimensions. If you set the ad border to None, the border is shown as a
dotted line.

The black square at the bottom right of the ad border is the Ad Resize
Handle. Drag the Ad Resize Handle to change the size of the ad.

The Desk Area
The Desk Area surrounds the Ad Area. The Desk Area is a good place to
experiment because it works great as a “pasteboard” to create or store
objects for composition before moving them onto the Ad Area.

Title Bar
The title bar is located at the top of the Ad Window.

The title bar displays:

• Ad title or name. When you save your ad, the ad name appears in
the title bar.

• Layout number. Because Creator lets you create and work on
several different layouts at once, “Layout #” tells you which layout
is displayed.

• Percent view. You can view the layout at several different
percentages: Fit in Window, Actual Size, 25%, 50%, 100%, 200%,
400%, or 800%. Percent view shows the percentage of the current
view.

User’s Guide          5



Menu Bars
Creator has two menu bars—one for Object mode and one for Text mode.

Object Mode:

Text Mode:

You can move quickly between Object and Text mode by pressing the Enter
key on the numeric keypad or by holding down the Command key and then
pressing the Tab key.

Creator commands are organized logically by the menu bar so that you can
quickly discover where to find what. When you pull down the menus,
you’ll notice that certain menu items are dimmed. A dimmed command
can’t be chosen because it is—for the moment—inappropriate or not
available. For example, the Paste item in the Edit menu is dimmed if
nothing has been cut or copied to the Clipboard.

6          Multi-Ad Creator



Object Menus
If any tool other than the Text tool is selected in the Tools palette, you are in
Object mode and the following menu choices appear:

•   menu
Access to desk accessories, Control Panels, the Chooser, aliases, etc.

• File menu
Access to standard as well as Creator-specific commands: New,
Open, Close, Save, Save As, Save Default Document, Delete, Place,
Import Text, Export, Page Setup, Print, and Quit.

• Edit menu
Access to editing commands: Undo, Cut, Copy, Paste, Clear, Select
All, Duplicate, Make Matrix, Subscribe To, Subscriber Options, and
Preferences.

• View menu
Access to commands that dictate your view of the ad: Actual Size, Fit
in Window, Enlarge, Reduce, Rulers, Guides, Invisibles, Rough, Tools,
Commands, Colors, Styles, Files, and All Layouts.

• Objects menu
Access to commands that manipulate objects: Set Size, Rotate, Flip
Horizontal, Flip Vertical, Gradient Fill, Line Weight, Line Type,
Print Attributes, Smooth, Unsmooth, Reshape, Auto Mask Graphic,
Mask Graphic with Shape, Add Shape to Mask, Edit Mask, Delete
Mask, and Same in All.

• Arrange menu
Access to commands that arrange objects: Group, Ungroup, Bring
To Front, Send To Back, Center Horiz., Center Vertical, Align
Objects, Space Objects, Setup Guides, Guides, Wrap Text, Split
Text, Fit Text Block, Drop Shadow, Mark as Art, Lock, and Unlock.

• Ad menu
Access to commands that manipulate one or all layouts: Layouts,
New Layout, Go To, Check Spelling, Check Selection, Spelling
Rules, User Dictionary, Ad Size, Ad Border & Fill, Ad Note &
Keywords, Suggest Layout, Set Rules, Favor Object, File Utilities,
Font Utilities, Formatting Rules, Style Sheets, and Define Colors.

• Window menu
This menu displays the names of all open Ad Windows, plus the
Paint Window and the Clipboard.

User’s Guide          7



Text Menus
Selecting the Text tool in the Tools palette puts you in Text mode, where five
new items are added to the Edit menu and four new menus are added to the
menu bar:

• Edit menu
Additional commands under this menu are: Find/Change, Copy Char
Specs, Paste Char Specs, Copy ¶ Specs, and Paste ¶ Specs.
Edit commands not available in Text mode: Duplicate, Make
Matrix, Subscribe To, and Subscriber Options.

• Text menu
Access to commands that manipulate text: Flush Left, Flush Right,
Center, Justify, Hyphenation, Copy Fit, Character, Paragraph, Tab
Ruler, Make Type Style, Make ¶ Style, Make Style Model, and
Thesaurus.

• Font menu
Access to all typefaces installed in your system file, such as Avant
Garde, Bookman, Courier, Helvetica, and so on. Access to an easy-to-
use Font List with an accompanying keyboard command. You can
control which fonts appear in the Font menu with the Customize
command.

• Style menu
Access to a variety of typeface styles and modifiers: Plain Text, Bold,
Italic, Underline, Outline, Shadow, Condensed, Extended, Filled
Outline, Filled Shadow, Superior, Inferior, Superscript, Subscript,
Case, Make Fraction, Kern, Horizontal Scale, Offset, and Word Space.

• Size menu
Access to a variety of different typeface sizes as well as the ability
to adjust the leading. Preset choices range from 9 pt. to 72 pt. You
can also add custom sizes to the Size menu with the Customize
command or apply a type size not listed on the type size menu with
the Size/Leading command.

Keyboard access to commands
After you’re familiar with Creator, you may want to forgo the Menu Bar and
access menu commands from the keyboard. Keyboard shortcuts are listed
directly across from the commands in the pull-down menus, and they allow
you to keep your hands on the keyboard and increase your ad design speed.
In many cases, you’ll find that Creator keyboard shortcuts are the same as
those used in other Macintosh programs.
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The Status Area
The Status Area is located in the lower left corner of the window.

Status Labels Status Area Status Area
Resize Bar

Creator’s Status Area displays “progress reports” and other information
about a command or action as you perform that command or action and
after it is completed.

The Status Area:

• Shows the size and position of objects as they’re being resized,
moved, or scaled.

• Confirms menu commands chosen with Command keys.

• Displays other Creator-specific messages.

You can make the Status Area larger or smaller by dragging the Status Area
Resize bar at the right of the Status Area. If you drag the bar to the far left,
the Status Area disappears, giving you the largest possible horizontal Scroll
Area. To display the Status Area again, drag the bar to the right.

Status Labels
You use the Status Labels pop-up menu to choose a label that describes
what stage of production the ad is at. Is it at the creative stage? Or is it ready
for quality control or customer approval? You can add or delete labels from
the pop-up menu in a dialog box accessed by choosing Status Labels from
the Preferences submenu.

If you don’t plan to use the status labels, you can remove the pop-up menu
from the Ad Window by deselecting the Show Status pop-up checkbox in the
Status Labels preferences. This will enlarge the Status Area.
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Rulers
If Rulers is checked in the View menu, rulers are shown at the top and left
sides of the Ad Window.

Rulers

The ruler units are determined by settings in the General Preferences dialog
box:
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Guides
You create guides by clicking on the Ruler. Once you’ve clicked to create a
guide, you can move it by dragging it across the Ad Ruler or remove it by
dragging it off the ruler. Clicking on the vertical ruler gives you horizontal
guides and clicking on the horizontal ruler gives you vertical guides.

Horizontal 
Guides

Vertical Guides

You can also use the Setup Guides dialog box (from the Arrange menu) to
create a grid of guides or to set custom guides that mark margins, columns,
and more. If you’ve created guides (or a grid) in the Setup Guides dialog
box, guide markers are shown on the rulers.

The Guide Snap Toggle
The Guide Snap Toggle control is in the upper left corner of the rulers.
SNAP ON: SNAP OFF:

Guide Snap Toggle

Clicking the Guide Snap Toggle controls whether “snap to guides” is turned
on or off. If the gray rectangle is pushed up against the crossing lines, then
snapping is activated. If the rectangle is pushed down and away from the
lines, then snapping is turned off.

When the Guide Snap Toggle is on, objects placed within the “snap
distance” of a ruler guide become aligned against that guide. If you come
within 1/4-inch of a guide while dragging or resizing objects, the objects
“snap” to that guide.
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Ruler Zero Points
The Guide Snap Toggle is also a starting point for setting Ruler Zero Points.
Grab the snap toggle area with the pointer and drag into the Ad Window. A
vertical and horizontal line tracks your movement. When you release the
mouse button, the new zero points are set.

To reset the zero points to the top and left edge of the ad, Cmd-click (press
and hold the Command key and click) in the snap toggle area.

Window Resizing Box
Located in the lower right corner of the screen, this box can be used to
manipulate window size by clicking, holding, and dragging.

By making the Ad Window size smaller, you can view several different Ad
Windows at once.

If Fit in Window is checked in the View menu, resizing the Ad Window fits
the ad to the new window size. The size and position of the Ad Window,
along with the ad, are saved when you save.

Zoom Box
The zoom box is in the upper right corner of the Ad Window, in the title bar.

Clicking the zoom box instantly resizes the Ad Window to take full advantage of
your monitor’s screen area. Clicking again returns the window to its previous
size.

Double-clicking on the title bar of the active Ad Window has the same effect as
clicking the zoom box. This is helpful when the zoom box has been moved off-
screen.
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Scroll Bars And Scroll Boxes
The scroll bars and scroll boxes are located on the right side of the window and
along the bottom. The scroll box is the white square on the scroll bar.

Scroll Boxes

Drag the scroll box or click on the scroll bar to move through a document
larger than the Ad Window. Click the arrows to scroll the screen a little at a
time.

Close Box
The close box is in the upper left corner of the Ad Window.

Clicking the close box closes the active Ad Window. If you haven’t saved
your changes, Creator prompts you to do so.
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THE COMMANDS PALETTE

Creator features a Commands palette that provides you with shortcuts to 15
of the most frequently used Creator commands:
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 Front

Sen
d to
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Drop Shad
ow…

Defi
ne C
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You simply click the button of the command you wish to perform. Where
appropriate, like with Print or Gradient Fill, a dialog box is displayed after
you click the button. With other buttons, such as with Flip Horizontal or
Move to Front, the action is performed as soon as you click the button. A
button is dimmed when the command is not available.

Modifier key options are available. For example, if you hold down the Shift
key as you click on the Bring to Front button, the command becomes Bring
Forward, just as it would if you held down the Shift key and chose the
command from the menu.

Note: For specific information on each of these 15 commands, please refer to
your Creator Reference Manual.

The Commands palette is a “floating” palette that can be dragged to a new
location. You can also click the palette’s Zoom box to reshape it. It can be
displayed in one of three ways: a row, a column, or a row with a Help area
listing the command for the button the Arrow pointer is pointing to:

Click here to remove 
the palette from view

Click here to 
reshape the palette

If the Commands palette is not displayed, choose Commands from the View
menu to display it.
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THE TOOLS PALETTE

The Tools palette is initially located at the right of the ad window.

It contains the tools used to build an ad. The Tools palette is a “floating”
palette that can be dragged to a new location. You can also reshape the
palette; click its Zoom box to toggle among the following shapes: a column,
a row, or a rectangle.
You can hide the Tools palette by clicking its close box, by pressing Option-
Tab, or by deselecting Tools under the View menu. To display the Tools
palette again, press Option-Tab again or choose Tools from the View menu.
Creator is an object-oriented application program; everything you create or
import into your layout is an object. Once you create an object or import one
from another source, it can be manipulated using the palette tools, menu
commands, and its Object dialog box. You must first select an object to
manipulate it.
Objects you can create with the Tools palette include the following:

• text blocks
• rectangles and rounded rectangles
• ovals and circles
• lines
• special “EPS Effects”
• irregular polygons
• freehand curves
• starbursts and regular polygons
• borders

Double-clicking these objects displays a dialog box of options which gives
you more control over how a particular object can look. The object dialog
boxes, along with the Tools palette, increase your design power.
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The first four tools in the Tools palette let you manipulate objects you’ve
created or imported by selecting, moving, cropping, or rotating them.

Arrow tool

Cropping toolText tool

Rotate tool

This part of the Tools palette also includes a Text tool (the “A”) which lets
you create and edit text blocks.

The remainder of the Tools palette contains several Drawing tools:

To draw an object
Click to select a graphic object in the Tools palette. Then, in the ad area, click
and drag to create the object. After you’ve drawn the object, the pointer and
palette revert to the Arrow tool so that you can resize, move, or manipulate
the object.

Tip: If you Cmd-click to select a tool, you are able to draw multiple objects
of the same type. If you don’t Command-click, the selected tool reverts
back to the Arrow tool after you’ve drawn your object.
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THE ARROW TOOL

Clicking the Arrow tool changes the pointer to the familiar arrow shape.
Use the Arrow tool to do the following:

• change the ad size
• select one or more objects
• draw objects
• drag objects
• resize objects
• access object dialog boxes by double-clicking the object

Objects can be selected in a variety of ways using the Arrow tool:

• by clicking

• by dragging a selection rectangle around multiple objects to select
all objects within the rectangle (also called “lassoing”)

• by shift-clicking to select or deselect multiple objects

Any object in the Ad Window or Desk Area can be selected, dragged, or
resized. The object can be in the ad or on the Desk Area around the ad. Once
objects have been selected, they have handles (black rectangles) on each
corner and along their sides.

After you’ve selected an object, you can do any of the following:

• Resize it by dragging the handles. If you want to proportionally
resize an object, press the Shift key while dragging the corner handles.

• Move it by placing the cursor over the frame of the object (or in the
object, if it’s a solid-colored object). Pressing and holding the Shift key
after you’ve begun to move an object causes it to move in a straight,
horizontal, or vertical line (depending on the direction you move it).

• Open an object’s Object dialog box by double-clicking the object or
one of the object’s handles. You can also access an Object dialog box
by selecting the object and pressing the Return key.
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Tab Key Selection
Of Objects

Pressing the Tab key while the Arrow tool is selected lets you select the
“next object.”

After you’ve tabbed to the “last object,” the next tab deselects all objects.
This is useful when selecting objects under other objects, small objects, or
elements on a crowded page. The tab succession might not take you
immediately to an object, but you’ll eventually get there.

Creator provides you with an even quicker way to select objects located
directly under other objects. If you hold down the Command key while
clicking on the top object, objects underneath are selected one at a time.

1 8          Multi-Ad Creator



THE TEXT TOOL

Clicking the Text tool switches Creator from Object mode to Text mode.
This causes two rather obvious changes. First, the Text tool in the Tools
palette is highlighted:

Second, Creator’s menus change; the Object mode menus are replaced by
menus that are specific to Text editing. Third, the Place button in the Files
palette changes to the Import Text button.
Use the Text tool to do any of the following:

• Create new text blocks by clicking and dragging with the Text tool.
When you release the mouse button, you’ll see the newly created
block, with the insertion point in the top left corner:

• Edit text. Creator uses standard Macintosh editing techniques. If
you’re not familiar with editing text, refer to your Macintosh
documentation.
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• Flow text from one block to another by clicking the widget at the
lower right of a text block and then dragging a new block:

Control key shortcuts
By pressing and holding the Control key, you can change the behavior of
the Text tool and expand the Text tool’s capabilities.

• If a text block is selected for editing text, holding down the Control
key and clicking and dragging in the text block moves the text
block.

• If a text block is selected for editing text, holding down the Control
key and moving within five points of its edge or corner changes the
pointer into “pinching fingers.” Dragging with this pointer resizes
the text block.

• If a text block is not selected for editing text or if the Text tool is
inside of an active text block, holding down the Control key and
clicking allows you to draw a new text block on top of an existing
text block instead of selecting the existing text block.
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THE CROPPING TOOL

The Cropping tool lets you hide parts of graphics objects (PICT, TIFF, RIFF,
EPS, GIF, JPEG, and MacPaint® objects) for size or aesthetic reasons.

You can crop the top, bottom, or sides of objects. Cropping lets you remove
superfluous details from the side(s) of the object.

To crop
1. Select the Cropping tool.

2. Position the tool over one of the object’s handles.

3. Click and drag for the desired effect.

If you release the mouse and move the tool within the borders of the crop, it
changes to the following tool: 

You can then press and hold down on the mouse key to use this tool to drag
the object around within its cropped borders.
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THE ROTATE TOOL

The Rotate tool lets you rotate objects, including text blocks. You can rotate
an object by selecting it with the Rotate tool and clicking and dragging it to
the desired degree of rotation. Or, you can select an object and double-click
on the Rotate tool or choose Rotate from the Objects menu to display the
Rotation dialog box:

Here, you can enter the exact amount (in degrees) for rotation.

When you use the Rotate tool to rotate objects that were drawn in Creator or
graphics that have been masked, you see the actual outline of the object
being rotated. When rotating placed graphics that are not masked, you see
an outline defined by the object’s selection handles  being rotated.

Rotating shapes drawn in Creator Rotating unmasked graphics
or masked graphics
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If you are using a Power Macintosh, you can hold down the Control key
while you rotate to see the entire image rotate, not just its outline.

Note: If you use a 16-bit monitor, you may, at times, see a sort of  “color
shift” to 8-bit colors when you use the Control key method of rotation
on a Power Macintosh. If Creator needs more memory to perform a
rotation, it will use 8-bit colors during the rotation. If there is still not
enough memory for Creator to perform the rotation, you will see the
outline of the object rotating instead of the entire object.

While rotating an object, the current degree of rotation is displayed in the
Status Area in the lower-left corner of the window.

Rotation is in 1/100-degree increments. If you hold down the Shift key
while rotating, it constrains the rotation to 1-degree increments. Hold down
the Shift-Option while rotating, and movement is constrained to 22 1/2-
degree increments, allowing you to rotate quickly in increments of 45 or 90
degrees.

In the Rotation dialog box, you can rotate to or rotate by any degree between
-360 degrees and 360 degrees. You enter negative numbers for counter-
clockwise rotation.

Rotate to lets you specify a precise angle of rotation, regardless of the
current rotation (if any). If you say “Rotate to: 33,” the object rotates to 33
degrees.
Rotate by lets you add or subtract from the current angle of rotation. If the
object is currently rotated to 33 degrees, and you specify “Rotate by: 1,” the
object will rotate one additional degree, to 34 degrees.

To rotate objects
1. Click on the object with the Rotate tool or select the object and choose

Rotate from the Objects menu.
2. Click on a handle of the selected object and drag to rotate.
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DRAWING, SELECTING, AND MOVING

About Object Dialog Boxes
Everything you draw or import into Creator is considered an object—even
text blocks—and every object has an associated Object dialog box. The
Object dialog box gives you control over the object’s characteristics,
including the following:

• fill color
• frame color
• line type
• line weight

To access the Object dialog box of an object
Double-click on the object or select the object and press the Return key.

Please see Chapter 3 of the Reference Manual for a complete listing of
Creator’s Object dialog boxes and their features.

Drawing Rectangles
And Squares

To create a rectangle, you click on the Rectangle tool in the Tools palette:

Then, in the Ad Window, the arrow pointer becomes a crosshair and you
drag to create a rectangle.

To create a square, hold down the Shift key while you drag to constrain the
rectangle to a square.
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To set the amount of corner roundness, double-click the Rectangle tool. This
dialog box appears:

For corner roundness, drag the control at the upper-left (the double arrow)
or type in a value.

Tip: If you hold down the Shift key while dragging the control, the
roundness increments will change in 1/8-inch increments.

Once you’ve created the rectangle, double-clicking it displays the Rectangle
Object dialog box, where you can change the corner roundness and other
rectangle characteristics. For more information on the Rectangle Object
dialog box, refer to Chapter 3 of the Reference Manual.

Drawing Ovals And Circles
Ovals and circles are created in the same manner as rectangles. Select the
Oval tool in the Tools palette:

Then drag to create ovals. Hold down the Shift key while dragging to create
circles.

Double-click on the oval or circle to display the Oval Object dialog box,
where you can change the object’s attributes. For details, refer to the Ovals
section in Chapter 3 of the Reference Manual.
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Drawing Lines
To draw a line, select the Line tool and drag a line.

Straight lines and 45-degree lines are the default since they are used most
often.

To draw other diagonal lines, hold down the Shift key while drawing the
line.

You can set the width (weight) of the line before or after you draw the line.
To set the line weight prior to drawing, double-click the Line tool in the
Tools palette and select a line weight in the resulting dialog box.

To set the line weight after drawing, double-click on the line itself for the
Line Object dialog box and click on the Weight field.

For more information on the Line Object dialog box, please refer to the Lines
section of Chapter 3 in the Reference Manual.
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Drawing Irregular
Polygons

The Irregular Polygon tool lets you create custom polygons.

To draw polygons, you use a method we’ll call “rubberbanding.” Creating an
irregular polygon is a matter of clicking to set the “corners” of the shape.

There are two types of irregular polygons: closed polygons and open polygons.

To create a closed polygon
1. Choose the Irregular Polygon tool.

2. Click in the Ad Window.

3. Move the pointer.

• You’ll see a small rectangle where you clicked and a line attached
to the pointer.

• The line begins where you clicked. It ends when you click again—
and another line is rubberbanded from the pointer.

4. Keep rubberbanding and clicking until you’re ready to close the polygon.

5. Click in the small rectangle (at the starting point) to close the polygon.

Creating an open polygon is similar, but instead of “closing” the polygon
with a final click, you double-click anywhere. That double-click sets the end
of the open polygon.

After you’ve drawn an irregular polygon, you can choose Smooth from the
Objects menu to smooth its appearance.
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Choose Unsmooth from the Objects menu to return to the original shape.

Drawing Freehand Lines
The Freehand drawing tool is used to create freeform lines.

To access the Freehand drawing tool, click the freehand shape on the palette.

Dragging now draws freehand lines. When you release the mouse button, the
line is automatically smoothed (and smoothed further when printed).

When you double-click on polygons, lines, and other objects created with
either the Freehand tool or the Irregular Polygon tool, the Polygon Object
dialog box opens and lets you alter standard attributes.

For more information on the Polygon Object dialog box, please refer to the
Polygon section of Chapter 3 in the Reference Manual.  Look under the
Reshape command in the Reference Manual for other features and options
available with freehand lines and polygons.
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Drawing Starbursts
Starbursts are created in the same manner as other objects: select the
Starburst tool in the Tools palette:

Then, click and drag in the Ad Window. Starbursts, however, have some
unique characteristics.

When you first create a starburst, you’ll get a default starburst with a preset
number of star points.

You can, however, customize the starburst in a number of ways.

1. Double-click on the starburst to bring up the Starburst dialog box.

Drag to change the starburst shape

Depth of "every other" point
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2. From the dialog box, you can control the options that starbursts share
with other objects: fill, line color, weight, and type.

3. You can also set starburst-specific options:

• the number of star points

• the depth of each point

• the depth of alternate points

• a random factor to make unique starburst shapes

When drawing starbursts, there are a few limitations:

• The maximum number of points is 40.
• The maximum Random value is 25%. To find a random shape you

like, enter a value in the Random field and click Apply.

You can also change the shape of a starburst with the Reshape command.
This is the “do-it-by-hand” method of creating a starburst. Select the
starburst, then choose Reshape from the Objects menu and drag a handle to
reshape each point as desired.
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Be sure to experiment with starbursts. Many different shapes are possible.
When you find a shape you like, you might want to duplicate it a few times
for use in the ad or copy it to the Scrapbook for safekeeping.

The smoothing feature can be used with starbursts as well. After you’ve
drawn a starburst (or any other polygon shape), you can round it out by
choosing Smooth from the Objects menu.

If you don’t like the effect, choose Unsmooth to return to the original.

Tip: Hold down the Option key while dragging the sizing controls in the
Starburst dialog box to resize the starburst symmetrically.

To get a clear preview of your starburst
within the Starburst dialog box, click
the icon showing a starburst with no
tools:

The Starburst tool also lets you create other regular polygons. Double-click
on the Starburst tool to bring up the other choices.

Click on a new polygon, and it replaces the starburst in the palette.

The first item in the regular polygon palette is a starburst. The others are
shapes with increasing numbers of sides: 3-, 4-, 5-, 6-, 7-, and 8-sided
polygons. Also included is a 5-pointed star. Each regular polygon you create
has an associated Object dialog box. Don’t forget that pressing Return is a
fast way to open the dialog box of a selected object.
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Using EPS Effects
You can create custom EPS (Encapsulated PostScript) effects with the “f/x”
tool:

Click on the f/x tool, then drag a rectangle for the effect. When you release
the mouse button, a dialog box is shown.

Choose an effect from the Effect pop-up menu. Type the text you’d like to
use in the Text field. When you click OK, you’ll see an approximation of the
effect. The results look “jaggy” on-screen to maximize program speed, but
they’ll look fine when printed.

For a printout of Creator’s special effects, refer to Appendix B of the
Reference Manual. Remember, the Effects tool creates graphics, not text. The
Text tool cannot be used to edit a special effect; you must double-click on
the effect and use the EPS Effect dialog box.
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Drawing Borders
You can create borders to surround ads or draw borders within ads.

To create an ad border
1. Double-click on the ad border (ad rectangle) or select Ad Border & Fill

from the Ad menu.

2. Choose Custom from the Border Type pop-up menu.

3. When you select Custom, the Corner Radius area is replaced by the 
Border file pop-up menu and the Border list. Choose a border file 
from the Border file pop-up menu.
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4. Click on the border of your choice in the scrolling Border list and 
click OK.

Creating borders in ads
1. Click on the Border tool in the Tools palette to select it:

Then, drag a rectangle in the ad window. When you release the mouse
button, a bordered box appears. The type of border depends on the last
border you selected.

To select a border type before drawing, double-click on the Border tool
in the Tools palette to bring up the following dialog box.

Scroll through the list of borders, select a border, and click OK. The
border changes accordingly.
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2. After you’ve drawn a border in the ad, double-click on it to display the
Border Object dialog box.

3. You can change the border type or select a color (or gray or pattern) for
the border’s frame and fill.
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Drawing On And Off The Ad
You can create objects in the ad border or outside the ad border. If, however, an
object is only partly within the ad border, only the portion within the ad border
is displayed. This, however, is a default setting and not a limitation. Creator’s
Page Setup settings can be changed to allow the printing of objects residing on
the Desk Area. See the Creator Reference Manual for more information on Page
Setup settings and Print options.

Selecting, Moving
And Resizing

This manual assumes that you are familiar with the basic Macintosh
interface. In general, selection and movement in Creator are the same as in
other Macintosh applications.

To select an object in the Ad Window
When you place the Arrow pointer over an object and click, black selection
handles surround the object.

Resizing Objects
To resize an object, move the pointer over one of the object’s selection
handles. The pointer becomes a “pinching fingers.”

Drag to resize. To make the object smaller, drag toward the inside of the object.
To make it larger, drag away from the object. Resize the object proportionally
by holding down the Shift key as you drag a corner handle.
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Moving Objects
To move or drag an object, place the pointer inside the object (if it’s a solid
object), or over the object’s frame (if it’s a transparent object).

Press and hold down the mouse button and drag. If you’re moving an object
by its frame, be sure that you don’t click and drag on a selection handle or
the object will resize. To move an object, the pointer must be an arrow.

Constraining Movement
During Dragging

Use the keyboard to constrain the movement of objects being dragged.

• If an object is deselected, select it, then drag it. After you’ve begun the
drag—and only after you’ve begun dragging—hold down the Shift key,
and the movement of the object is constrained. You’re not limited to one
axis. You can drag horizontally, vertically, or diagonally, and you can
change directions in mid-drag, if you wish.

• You can release the Shift key during the drag to unconstrain and then use
the Shift key again during the same drag to constrain again.
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ABOUT GRAPHICS

There are two general types of Creator objects: objects that you create in
Creator and graphics that you place from other sources.

Graphics can be any type of graphic from virtually any source. They may be
graphics created in other Macintosh programs or graphics (or photos or
logos) scanned in by a scanner. Or, they may be graphics you purchased for
use with Creator.

File Types You Can Place
Graphics that you can place in Creator include:

• MacPaint files (or other programs that save in MacPaint format—
including most scanner software)

• RIFF files, non-color only

• PICT files

• EPS files that were saved with a preview
If you place an EPS file containing a font that is not installed on
your computer, Creator reports the missing font when you try to
print the graphic. The message will try to suggest which fonts are
missing.

• JPEG files

• GIF files

• Most TIFF files
For a listing of TIFF files accepted by Creator, please refer to the
appendix on Creator File Formats in the Reference Manual.
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PLACING GRAPHICS
To get graphics into the ad, you must place (or import) them into Creator.
There are several ways to do this.

Placing Graphics Without Options
1. Choose Place from the File menu. The Place dialog box is displayed.

2. Make sure that the “Place with cursor” option is not selected
3. Select a graphic. If the “Show preview” checkbox is selected, Creator provides

a thumbnail preview for placeable files that were saved with a thumbnail
preview in the application program that created them.
You can narrow down the list of files in two ways:

• Choose specific file types from the Show menu to have Creator
display only those file types.

• Select the “Hide unplaceable files” checkbox to remove any
unplaceable files from the files list. For example, Creator cannot
place EPS files that were saved without a graphics preview. If you
select the “Hide unplaceable files” checkbox, those EPS files will be
removed from the list of files.

Note: It may take Creator some time to list the files in a folder that contains
many EPS files.

4. Click Place. The image, unless it’s a MacPaint file, appears in the Ad
Window. If the image is a MacPaint file, it appears in the Paint Window,
where you can select part of the image to copy to the ad. The Paint
Window is explained later in this guide.
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Placing With Cursor
To place a graphic in an exact location, select the “Place with cursor” option
in the Place dialog box.

1. Choose Place from the File menu.

2. Select the “Place with cursor” option:

3. Select a graphic.

4. Click Place. The Place dialog box disappears and the pointer changes:

You’re now ready to place the graphic precisely where you wish.

5. Click in the ad to set the position of the graphic’s top left corner.

OR

Drag a rectangle for the graphic to appear in. If you hold down the Shift key
while dragging the rectangle, the image is scaled proportionally and the
percentage of scaling graphics is shown in the Status Area.

Placing by using Drag and Drop from the Finder
Creator supports System 7.5’s drag-and-drop features, allowing you to
place graphics and text files into Creator directly from the Finder.
To drag-and-drop an item from the Finder
1. Open the Creator ad in which you want to place the file or files.

2. Drag any placeable text or graphics files or picture “clipping” files from the
Finder onto the open ad window. You can also drag pictures from the
System 7.5 Scrapbook and other drag-and-drop capable applications.

A gray or colored outline frames the destination area of the ad window,
signaling that it is ready to accept the drag. The destination area of ad
windows includes the ad area and desk area, but not rulers, scroll bars, and
title bars.

3. Release the mouse button. The files are placed in the ad area.

Note: You can use this feature only if you are using System 7.1 with the
Macintosh Drag-and-Drop extension installed or System 7.5 or later.
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Drag-and-drop interface with Multi-Ad Search® 3.1
To place a file in Creator from Search 3.1, you simply drag the file’s record
from Search and drop it into an open Creator ad.

Note: You can use this feature only if you are using System 7.1 with the
Macintosh Drag-and-Drop extension installed or System 7.5 or later.

To drag and drop a file from Search 3.1 into Creator
1. Open the Creator ad in which you want to place the file or files.

2. Open the Search 3.1 catalogs that contain the records of the original 
files you want to place in the Creator ad.

3. In the Search catalog, select the records of the original files you want to
place.

Hold down the Command key as you select records to select more 
than one. To select a range of records, hold down the Shift key as 
you select the first and then the last record in the range.

4. Drag the selected records to the Creator ad. A gray or colored outline 
frames the destination area of the ad window, signaling that it is ready 
to accept the drag.

Note: Original files must be available on a mounted server or hard drive in
order to drag their records from Search and place them in Creator. If
the original files are not available, you are unable to drag an outline of
those records to Creator’s ad window.

5. Release the mouse button. The files are placed in the ad area.

Creator supports a subset of the file types that Search supports. If you try to
drag a file type to Creator that is not supported by Creator, the ad window
will not highlight and accept the file.
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EXPORT EPS, TEXT, CIF, GIF AND TIFF FILES

If you want to save your entire ad, or portions of it, as a graphic to place in a
new ad file or in another page layout program, you use the “Export”
command. To export a file, pull down the File menu and hold the mouse
button down on Export. A submenu containing five items is then available:
EPS file, Text file, CIF file, GIF file, and TIFF file.

When you export EPS, TIFF, or GIF files, thumbnail previews for the files
are automatically created. Creator uses these thumbnails to display
previews of the files in its Place dialog box.

Also when exporting EPS, TIFF, or GIF files, you can tell Creator to warn
you if an ad contains text that goes beyond the boundary of a text block.
You activate this feature by selecting the “on exporting graphics” checkbox
under the Check for Text Overflow heading in the Text Preferences dialog
box.

4 2          Multi-Ad Creator



Exporting EPS files
Choosing the first option allows you to export an ad or a portion of an ad as
an EPS file. The following dialog box is displayed:

Note: You can also click on the Export EPS button in the Commands palette
to display the Export EPS dialog box.

Export allows you to save the whole ad or just selected items in the ad as an
EPS file.

Preview type allows you to select the mode for previewing EPS files in
other programs. Choices are Color/Grayscale, Black & White, None, PC
Black & White (EPSP), PC Grayscale (EPSP), and PC Color (EPSP).

Note:  Creator will not place an EPS file that is saved without a graphics preview,
which is the preview you see on-screen after the graphic is placed. That is
the preview for which you are setting the Preview type.

A thumbnail preview—the preview you see in Creator’s Place dialog
box—is automatically created for each EPS file you export.

The Method pop-up menu allows you to include DCS (Desktop Color
Separation) file output for placing into other programs. The options available
are Composite, DCS v1.0 Separations (5 files), and DCS v2.0 (1 file).
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The DCS v1.0 option creates five files: one file for each of the four process color
plates (Cyan, Magenta, Yellow, and Black) and one composite file. It does not
create plates for any spot colors contained in the ad.

The composite file is the core document. When placing this graphic into a
Creator document (or any other application supporting DCS Files), the
composite file is used. When the document is then printed, this placed
composite file acts as a reference, informing the computer and printer where
the individual separations are located.

The DCS v2.0 option makes it easier to keep track of the separation files by
creating one file that contains pre-separations of each of the necessary colors
including spot colors. If your ad contains process colors, there will be
preseparated CMYK portions of the file. If the ad contains spot colors, there
will be preseparated portions of the file for those colors.

Trapping information included with the EPS files varies with the option
selected in the Method pop-up menu. In Creator 4.0, Composite EPS files will
include Overprint information, meaning that if an object is marked to
overprint (in the Print Attributes dialog box), that information will be
included in the EPS file. To also include information on chokes and spreads,
however, you must use the DCS v1.0 or DCS v2.0 option.
Binary encoding saves sampled image files using binary rather than
hexadecimal encoding. This can result in EPS files that are 50% smaller and will
print significantly faster. However, binary encoding is not supported by all
networks and RIPs. If in doubt, leave this option unselected.

When the Level 2 PostScript® option is selected, Creator uses PostScript Level 2
commands to create the EPS file. If your printing devices will always be
PostScript Level 2, creating the EPS file with Level 2 commands will improve
printing performance and speed. However, saving an EPS with Level 2
commands introduces a Level 2-device dependency into the graphic, so you
may experience much slower printing if you try to print such an EPS file with a
device that is not PostScript Level 2.

The Color PostScript® option uses PostScript code that is specially modified for
use with PostScript printers that can output color. This option should not be
used when creating EPS files that will be printed to black-and-white printers,
even if a color job is being sent to the printer to be separated. It is only for those
users who have color PostScript printers.
When the “Limit Resolution to” option is checked, you can specify the
resolution of image graphics (TIFF and RIFF) contained in the EPS file to be
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created. For instance, if you know that your final printing device will print
at a resolution of 1200 dpi, you can specify that the graphics in the EPS file
be limited to 1200 dpi.

Unlike the “Limit Resolution to” option in the Page Setup dialog box,
Creator does not get a default for the Limit Resolution field from a PPD.
You must enter a number.

Limiting the resolution of image graphics in an EPS file yields a smaller EPS
file that will print faster. However, there may be some loss of quality
depending on the settings used, the graphics included, and the printer the
file is printed on.

OPI options are two omit options that allow you save only those portions of
your ad that are not of EPS or TIFF format. When using either of these
options, Creator doesn’t send the actual EPS or TIFF information; instead, it
sends only comments. For those who use OPI (Open Prepress Interface),
these comments refer to the actual EPS and TIFF data. For those not using
OPI, the EPS and TIFF images are simply not saved.

Scale by allows you to scale the ad by a given percentage from 25% to 400%.

Scale to allows you to scale the ad to a specific size by entering different
measurements for width and length.

Using exported EPS files with Adobe Acrobat
Creator is fully compatible with Adobe Acrobat™ Distiller, starting with
Acrobat Distiller version 2.0. This program can convert EPS files created
with Creator to PDF files that can be read by Adobe Acrobat. From within
Acrobat, you can print the PDF files to non-PostScript devices or fax them
electronically. Please refer to your Adobe Acrobat documentation for
instructions on converting the EPS files and working with them in Acrobat.

For additional details, please see the section on Exporting EPS files in the
Reference Manual.
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Exporting text files

1. Choose the Export—Text File option from the File menu to export ad
text or portions of ad text to a text file:

2. Type in a filename or use the default name. Specify a location for the
exported file.

3. Set other options:

The Save text file as pop-up menu appears when the Claris XTND
System is installed on your computer. It gives you the option of saving
formatted text in other file formats, depending on what translators are
installed.

Active blocks only lets you export only the blocks that were active
(selected with the Text tool) when you chose “Export Text file” from
the File menu. If no text blocks were active, this option will be
dimmed.

4. Click Save. The ad’s text is saved as a Creator Text file. If this file is
imported back into Creator, it will come in with formatting. If opened by
any other program, it will open as plain, unformatted text.
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Exporting CIF files

The third option, Export CIF file, allows you to save your ad in Creator
Interchange Format (CIF).

CIF is a structured, documented file format that can be used as an
intermediate form for converting other programs’ documents to Creator or
Creator’s documents to other programs. It can also be used by ad
management systems as a format for creating starter ads.

Multi-Ad Services publishes the CIF specification and a CIF Developer’s
Toolkit for those interested in using this format. For more information, please
call the Creator product director at 309-692-1530 or send e-mail to:
creator@multi-ad.com.

The “Save ad preview” option saves a thumbnail PICT preview in the CIF
file. This preview is used to show a thumbnail preview of the ad in
Creator’s Open dialog box. It is also used by the cataloging programs Multi-
Ad Search or Adobe Fetch™  to provide a thumbnail view of the file once
the file is cataloged. Keywords and descriptions are also saved.
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Exporting GIF files
This option lets you export an ad or selected items in an ad as a GIF file,
which is a platform-independent bitmap format. You would use this
feature, for example, to create files for World Wide Web pages.
1. Choose GIF file from the Export submenu under the Edit menu.

2. Type in a filename or use the default name and specify a location for
the saved file.

3. Set other options as necessary:
Export lets you specify what you want to export as a GIF file: the
whole ad or just selected items in the ad.
Export Color options let you specify a color depth for the exported file.
Options are: 256 Colors (8 bit), 256 Grays (8 bit), and Black and White
(1 bit). Choosing Black and White will create a smaller file than
choosing 256 Colors or 256 Grays.
The Interlace checkbox should be selected when you want the GIF file to
have the ability to be downloaded in “waves” rather than just linearly
from top to bottom. As interlaced images are downloaded, you get a
representation of the entire graphic more quickly.
Export Size options let you select a size for the GIF to be created, with Full Size
equaling the current size of the ad or ad elements you are going to export. The
larger you make the exported GIF, the larger the file’s size becomes.

4. Click Save to create the GIF file.
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Exporting TIFF files
1. Choosing TIFF file from the Export submenu lets you to export an ad

or selected items in an ad as a TIFF file, which is a bitmap format. The
following dialog box is displayed:

2. Type in a filename or use the default name and specify a location for
the saved file.

3. Set your options:
Export lets you specify whether you want to save the whole ad or just
selected items in the ad as a TIFF file.

Export Color options let you specify a color depth for the exported
files. Options are: 256 Colors (8 bit), 256 Grays (8 bit), and Black and
White (1 bit). Choosing Black and White will create a smaller file than
choosing 256 Colors or 256 Grays.

The Export Resolution options let you specify the resolution of the
exported TIFF file, keeping in mind the higher the resolution, the
larger the TIFF file that is created.
For example, a TIFF file saved at 144 dpi could be up to four times
larger than if it were created at 72 dpi. One saved at 288 dpi could be
up to 16 times larger than the 72 dpi file. File compression, however,
helps keep file sizes smaller.

4. Click Save to export the TIFF file.
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THE PAINT WINDOW

When a MacPaintfile is placed, it automatically appears in the Paint Window,
where you can select a portion of the graphic to appear in the ad.

You can also use the Paint Window at other times by selecting Paint
Window from the Window menu. You may, for example, want to paste a
graphic from the Scrapbook into the Paint Window so you can select just
part of it to use in the ad.

The Paint Window’s palette contains:
• a rectangular selection marquee
• a lasso tool
• a hand tool
• a pencil—for editing images
• an eraser—for erasing portions of images
• a Place button

If you’ve used MacPaint or other similar programs, these tools should be
immediately familiar.

The Selection Marquee
Use the selection marquee to drag a rectangle around the portion of the
graphic you wish to select. The graphic and any white space around the
portion chosen with the selection rectangle are transferred to the ad by
clicking Place.

Pressing the Shift key while dragging a marquee shrinks the selection to the
smallest enclosing rectangle possible. Pressing the Command key while
dragging a marquee gives you an effect similar to the shrink-to-fit lasso,
with one difference: Command-selection marquee acts as if you dragged a
square lasso, then shrank it.
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Lassoing
Select the lasso tool to draw a lasso around the portion of the graphic you
wish to select. Only the actual graphics in the lassoed portion (not its
surrounding white space) are transferred to the ad by clicking Place.

Creator uses a smart lasso. After you drag around an image with the lasso,
the lasso shrinks to enclose the image. Also, when you release the mouse
button, the lasso shrinks to enclose the image.

If you hold down the Option key while any tool is selected, it switches to the
Hand tool. If you hold down the Command key while selecting with either the
Lasso or the Selection Marquee tool, the selection is constrained.

The Hand tool moves the image in the Paint Window. To use the Hand tool,
select it. The pointer changes to a hand. Drag the hand in the Paint Window
and the image moves accordingly.

You can expand the Paint Window to full screen size by clicking the white
zoom box on the right side of the title bar. Click this box again to shrink the
window.

You can Option-Shift-click to enlarge the graphic (not the Paint Window), or
Option-Command-click to reduce the graphic. When you use either
keyboard command sequence, the pointer becomes a magnifying glass with
a plus or minus sign (depending on the command you used). This
magnifying glass won’t appear (and the expansion or reduction won’t take
place) unless the pointer is over a graphic and not over an empty gray area
in the Paint Window.

Note: Up and Down arrows also change the scale in the Paint Window.

Copying a selection from the Paint Window
1. Select the graphic.

2. Click Place:

Place brings the Ad Window to the front and places the graphic in the
Ad Window.
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WORKING WITH TEXT—FIRST THOUGHTS

You can use Creator to create text or to place text from other files. Creator
lets you format your text in traditional ways: font, style, size, and so forth.

You can also search for text, search and replace text as in other word
processors, or search and replace fonts, styles and/or sizes. For example,
you can change all text that’s 12-point Geneva Bold to 14-point Times Italic
Underline.

You can also apply precise formats to text: alignment, paragraph indents,
leading, or kerning—even change the case of type (to all uppercase, for
example).

Leading and text sizes can be in whole or fractional points.

You can copy a text format to other text, copy the format of a paragraph to
other text, and apply Type Styles, Paragraph Styles, and Style Models to
text.

You can have text in color or in grayscale.

In Object mode, you can scale text by holding down the Command key
while resizing a text block. The text scales vertically or horizontally to fit the
new block size.
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For more precise control, double-click on a text block while in Object mode
and set scaling values in the resulting dialog box.

For more information on the Text Block dialog box, please refer to Chapter 3
of the Reference Manual.

Blocks And Widgets
Blocks make things easier. You can have text from a single file shown in
many blocks. Each block can be a different size and have a different position
on the ad.

Small tabs, called “widgets,” in the lower right corner of text blocks are
used to show the order of text blocks. The last block in a text block has the
word MORE in the widget if there’s more text than is currently displayed. If
not, the word END appears in the widget.
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Other blocks of the linked chain of text blocks have widgets that are
numbered according to each block’s place in the succession of text.

To create additional blocks, place the Text tool over a widget. The cursor
becomes an arrow.

Click the widget and the pointer changes again, to a crosshair with an
ellipsis: 

To create the next text block, drag a rectangle with the crosshair. Remaining
text flows into the created block.

If the new block’s widget reads MORE, click its widget to repeat the process.
Keep clicking and creating new text blocks until a widget says END.

You can link a new block to any existing block—not just the last MORE or
END block—by clicking the existing block’s widget before creating the new
block.

All your text stays in the correct order and flows through all your blocks as
you’d expect. If you want another block somewhere, just make one!

Multiple block selections
A bit earlier, we mentioned selecting text. In general, selecting text in Creator is
like selecting text in any word processor: click and drag to select.

Creator also adds the ability to select text in multiple blocks if the blocks
have been linked by clicking each preceding block’s widget before creating
the next. To do this, just drag from one block into another.
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Text in intermediate blocks is selected when you drag from, say, the second
to the fifth block. Portions of text in unlinked blocks cannot be
simultaneously selected.

Creating Text From Scratch
You can also create text from scratch in Creator. As soon as a new text block
is created, the text insertion point appears, blinking, in the block’s upper left
corner.

All you have to do is start typing. If you’d like to choose a font, style, or font
size that’s different than the default in Text Preferences, make your choices
from the menus before you begin typing.

If you have much text to type, you might make one large block, enter all of
the text, and then “re-block” after you’ve created the text.
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STYLING TEXT

Creator offers you many ways to format text. Some are straightforward and
will be familiar to anyone who’s worked with other Macintosh programs.
Other ways to style text—Style Models in particular—are powerful text
styling methods that are unique to Creator.

Let’s start with the basics and move into more advanced ways to style text.

To change the appearance of text, you can:

• Choose a different font.

• Format the text.

You choose a font from the Font menu. Whatever text you’ve selected
changes to the font you’ve selected.

Text Defaults
But say you’ve just created a new text block and are about to enter text.
What’s the font?

The answer: Whatever you’ve selected as the default font in the Text
Preferences dialog box. To open the Text Preferences dialog box, choose
Text Preferences from the Preferences submenu under the Edit menu.

The top settings in the dialog box are the settings for new text blocks:

These settings also determine how text that you import into Creator is
initially formatted.
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But there’s another way to set the initial format for an empty text block. First
drag to make a text block, then choose a font from the Font menu, a style from
the Style menu, or a size from the Size menu (or all three).

When you start typing, the text appears in the font, size, and style you’ve
chosen. So, for example, if you make a new text block, choose Times from
the Font menu, Bold from the Style menu, and 18 from the Size menu, and
then begin typing . . .

If you don’t make any choices prior to typing, the text is formatted
according to the settings in the Text Preferences dialog box.

Standard Character Styles
Macintosh has what we’ll call “standard character styles.” In Creator, you’ll
find these standards at the top of the Style menu:

The important point about these styles is that they’re applied
“algorithmically” to text. Macintosh system software “redraws” the existing
font to make it bolder, for example.

Today, however, many PostScript fonts are offered in various faces, so you
can either choose Bold from the Style menu or you can choose a “Times
Bold” font (if you have one) from the Font menu.

In general, many popular PostScript fonts are offered in these faces: Plain,
Bold, Italic, and Bold Italic. Some fonts may also have versions that are
Light, Heavy, Extra bold, or other variations.
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Although it usually doesn’t matter whether you choose a bold font from the
Font menu or apply Bold from the Style menu, it’s good to choose the exact
font if it’s installed in your system.

Other ways to format characters are found below these standard styles:

For specific information about these commands, look in the Reference
Manual under the Style menu. Here, let’s just note that these are character
attributes that are applied to a range of selected text. First you select the
text, and then you choose a command to format it.

Complex Character Formats
You can apply many attributes to characters. Consider this text:

The attributes here are:
• Times, 20 point
• italic
• bold
• kerned, a bit
• greater-than-standard word spacing

Although the text contains several attributes, the formatting is consistent
throughout the text—it’s all the same font, same size, and so forth. To create
this text, you performed six separate actions.
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Saving Time In
Character Formatting

To save time, you’d like to use this same character format on other text in
your ad.

There are two ways to do this.

If you only want to use the format one more time, try this:

1. Select the text.

2. Choose Copy Char Specs from the Edit menu.

3. Select a range of text to receive the character attributes.

4. Choose Paste Char Specs from the Edit menu. The character formats are 
applied to the text you selected.

The second way to use formats over again is more powerful.

1. Select the text.

2. Choose Make Type Style from the Text menu. This dialog box appears:

The settings reflect the selected text. You can accept these settings or
make more changes in this dialog box. The sample text in the lower part
of the dialog box reflects the settings.

3. Name the Type Style. Click OK.
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The new Type Style—which we’ve named “Italic 20 head”—now
appears on your Styles palette. To view the Styles palette if it is not
visible, choose Styles from the View menu.

You can use this character format over again by following these steps:

1. Select a range of text in a text block.

2. Click on “Italic 20 head” in the Styles palette.

The selected text takes on the attributes of “Italic 20 head.”

Type Styles are a big timesaver. Use them whenever you want to use the
same text attributes many times.

Paragraph Defaults

When you first make a text block, there are two default paragraph
settings—paragraph alignment and hyphenation. They are found in the
Text Preferences dialog box, which is found by choosing Text in the
Preferences submenu under the Edit menu:

Choose left, right, centered, or justified for a default paragraph setting.
Hyphenation can be turned on or off. All other paragraph settings are initially
zero—no indents, no space before or after a paragraph, and no tabs.
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Paragraph Attributes
The easiest way to see the kinds of settings that apply to paragraphs—the
“Paragraph Specs”—is to open the “Make ¶ Style ” dialog box from the Text
menu.

Disregard, for now, the Type Style pop-up and the items at the top of the
dialog box. What we’re concerned with are the settings for attributes that
involve paragraphs. It’s important to remember that
the settings apply to entire paragraphs.
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Paragraphs are defined by Return characters (¶). Any text that ends with a
Return is a paragraph. When you press the Return key, you’ve made a
paragraph. To view Return characters, choose Invisibles from the View
menu and select the “Returns, tabs, newlines” option.

Now let’s format a paragraph to look like this:

Paragraphs are defined by
Return characters. Any text
that ends with a Return is a
paragraph. When you hit
the Return key, you’ve
made a paragraph. 

We used the Paragraph dialog box to make the changes:

The only changes from the default paragraph setting are the Left indent and
the four points of space after the paragraph.
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Saving Time In
Paragraph Formatting

There are two ways to save time when you want to use paragraph formats
over and over again.

The first method—as with character formats—is to use Copy ¶ Specs and
Paste ¶ Specs to copy and paste paragraph settings. Use this to copy the
attributes of a paragraph to another paragraph. The second method is to
make a Paragraph Style.

To make a Paragraph Style (“¶ Style”):

1. Click an insertion point in the paragraph containing the attributes you
wish to reuse. Since paragraph settings are consistent for each individual
paragraph, you don’t need to select the entire paragraph—just click in
the desired paragraph.

2. Choose Make ¶ Style from the Text menu.

You’ll see the settings in effect for the selected paragraph.
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3. You can change the settings here, if you wish. You might, for example,
add tabs by clicking on the ruler and set a character to be used for a Tab
leader:

4. Finally, name the new Paragraph Style and, optionally, choose a Shift-
Option keyboard equivalent:

5. Click OK.

6. The new Paragraph Style is shown on the Styles palette, along with a
keyboard equivalent, if you made one.

If you resize the Styles palette, you’ll see the entire name.

You can apply the Paragraph Style by clicking in a paragraph and then
clicking “Leader style” in the Styles palette or typing “Shift-Option-L.”
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Using Type Styles With ¶ Styles
Another powerful application for Creator’s styles presents itself when you
combine Type Styles with Paragraph Styles.

Here’s one example. Say you’ve made a Type Style named “Garamond”
with these characteristics:

You’d like to make a model that includes both Type and Paragraph
information.

You can include the Type Style in the Paragraph Style by using the Type
Style pop-up in the Paragraph Style dialog box:

When you next apply “Leader Style,” the text is formatted using the
paragraph settings and the type settings contained in the “Garamond” Type
Style.
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Using the “Based on” pop-up menu
The “Based on” pop-up menu in the Type Style and ¶ Style dialog boxes
allows you to build on existing styles to create new styles.

For example, say you have a Type Style named “Garamond” that is:

Font: Garamond
Style: Bold and Italic
Size: 12 point

To make a new Type Style that includes all the characteristics of
“Garamond,” but has one additional attribute, you would:

1. Choose Make Type Style from the Text menu.

2. Use the “Based on” pop-up to choose “Garamond.”

3. Make changes—possibly choosing “Red” as the text color.

4. Name the new Type Style.

When you click OK, the new Type Style is shown in the Styles palette:

Using the “Based on” pop-up menu, you can quickly create sets of Type and
Paragraph Styles.
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Style Models
Now let’s look at the most powerful way to format text: Style Models.

What are Style Models? Simply put, they’re sequences of type and/or
paragraph formats. A Style Model may also apply both Paragraph Styles
and Type Styles.

Consider a simple food listing. Drag a new text block and type the following
in a 12-point font:

Not too exciting.

What you want is this:

To create such a line, type the text in 12 point again and follow the steps
below to format it. Make sure you have your Invisibles turned on from the
View menu:

1. Change the font size of “Onions 49¢” to 18 point. For the purpose of the
example, please be sure to include the space after the cents symbol as 18
point.

2. Set a tab after “Onions.”

3. Set a tab leader in the Tab Ruler.

4. Make the cents symbol superior.

Here’s the challenge: you want to use this format many times, but you can’t
use a Type Style, because the formats aren’t consistent for the entire line (the
size differs and there’s that superior cents symbol).

Also, you can’t use a ¶ Style, because although the line ends with a Return,
what you’re looking for isn’t so much a Paragraph Style (with the exception
of the tab and Tab leader) as a Type Style. Actually, it’s a sequence of Type
Styles—perfect to capture as a Style Model.
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1. Begin to make your Style Model by selecting the entire line:

2. Choose Make Style Model from the Text menu. You see this dialog:

The characteristics of the Style Model are listed. Paragraph formats are
in bold. Below the paragraph formats are the type formats.

3. Double-click on the line “Paragraph 1 - Left…” (or single-click and then
click “Edit”), and you see a detailed view of the paragraph:
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4. Click OK to return to the Style Model dialog box. The four lines under
the “Paragraph 1” line are Type formats:

Together, they represent the entire sequence of styles—Palatino
18-point Plain, to Palatino Superior, back to Plain, then to Palatino
12-point Plain.

5. Double-clicking on any of these lines brings up a Character Format
dialog box:

If you want, you can further edit the style in this dialog box, as shown
above. Click OK to save your edits and return to the Style Models dialog
box.

6. Once you’re satisfied with the Style Model, name it and click OK:
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The new Style Model is shown in the Styles palette.

To use the new Style Model, select text then click the Style Model name in
the Styles palette. For more about Style Models, see the “Make Style Model”
section in the Reference Manual.
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PLACING TEXT

You can place the following text files:

• WriteNow™ 1.0 files (Character format information is preserved,
along with dates and times inserted into the text.)

• Text Only files

• Formatted MacWrite® 4.5 files

• Microsoft Word® 4.0, 5.0, and 5.1 files that have not been fast-saved

• Files saved in Microsoft’s Rich Text Format

Note:  Graphics in RTF files are imported with the text and then placed in the
Desk Area. Using RTF also lets you place formatted Word (or any RTF)
files produced on MS-DOS computers.

Placing into a new or existing block
1. Click the Text tool in the Tools palette.

2. Drag to create a new, empty text block.

3. Choose Import Text from the File menu.

4. Select a text file. Make sure the “Place with cursor” option is not
checked. Then, click Place.

5. The text flows into the block beginning at the insertion point. You can also
set an insertion point in an existing text block; the text you place is then
inserted beginning at the location of the insertion point.

Placing text with cursor
1. Choose Import Text from the File menu.

2. Select the “Place with cursor” option in the Import Text dialog box.

3. Select a text file and click Place.

4. Drag a new text block.

5. Release the mouse button and the text flows into the new block.
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Placing text with no options selected
Here’s the simplest but least user-controlled way to place text in an ad:

1. Choose Import Text from the File menu and select a file. Click Place.

2. The file is placed in a new text block created in the center of the window.

Placing text without any additional options also selects the Arrow tool so
you can immediately move or resize the selected block.

To place text using the Files palette

1. Choose Import Text from the File menu.

2. Select a text file to import.

3. Click the “Add to list” button to place the text file into the Files palette.
Or, if you want to add all of the text files listed in the current directory,
click the Add All button.
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Breaking imported text into blocks
The Break Text option lets you place text into more than one text block and
place each receiving text block by hand, one by one.

To use the Break Text feature, first prepare a text file in your word processor
or export text typed in Creator as a text file. Insert delimiters or characters
into your text; these delimiters signal where you want the text to break into
a new text block. A delimiter can be any character not otherwise used in the
text. Standard delimiters include \, ^, ~, and so on. You can also break text
after a specified number of paragraphs (¶).

After inserting the delimiters, save as you normally would and quit the
word processing application. Then complete the following steps.

1. Select Import Text from the File menu. The Import Text dialog box
appears.

2. Select a text file to import.

3. Click Break.

4. The Break Text dialog box appears:

5. Type in your delimiter. Here, we used a backslash, so a backslash
character is entered in the Characters field.

6. If you want every instance of this character to be stripped from the text
blocks as the blocks are placed, select the Delete box.
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7. Click Place. A dialog box appears with instructions:

8. Click OK.
9. Click and drag to create the first text block. All text previous to the first

delimiter flows into the text block. Continue to create text blocks until
you have placed all the text from the selected file.

The Status Area tells you the number of blocks remaining to be placed.

To cancel after placing any text block, press Cmd-period or choose Import
Text from the File menu. All remaining blocks are canceled.

Using Break Text with existing text blocks
There’s another way to use Break Text. Instead of dragging text blocks as
the text is coming in, you can put the text into existing text blocks.

1. Create empty text blocks by dragging. Create as many blocks as you’ll
have chunks of text to fill the boxes.

2. Using a text file you’ve already prepared as in the preceding example,
set up the Break Text dialog box and click Place.

Here’s where it becomes different.

3. Instead of dragging to create a text block for each chunk of text, move
the pointer over one of the empty text blocks and hold down the
Command key.
You’ll notice that the cursor changes to this: 

4. To place a chunk of text into the block, click in the block while holding
down the Command key.

This is a fast, efficient way to place chunks of text into existing blocks.
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For still more speed, create empty text blocks using the Make Matrix
command, which is found in the Edit menu when in Object mode. Make one
empty block, then choose Make Matrix to replicate rows and/or columns of
empty text blocks.

Now break text as before, remembering to hold down the Command key
while clicking in an empty text box. For more information about the Make
Matrix feature, look in the Reference Manual under Make Matrix.
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TABS

Tabs allow you to position text precisely in a variety of ways.

To position text horizontally on a line, always use a Tab stop. It’s tempting
to use the space bar instead, but that has drawbacks. The size of a space is
determined by the font, style, and size of the type. Tabs, however, always
mark a fixed location on a line. Change your font, size, or style and the tab
still stays where it is.

When you press the Tab key, a Tab character is inserted into the text. The
Tab character is normally an invisible character.

To see tabs in text (recommended when you’re creating text with tabs),
choose Invisibles from the View menu and check “Returns, tabs, newlines”
in the dialog box. Any tabs or returns you place in text are now visible:

The Tab Ruler
The Tab Ruler is displayed if you’ve chosen Tab Ruler from the Text menu.

A shortcut for displaying the Tab Ruler for a paragraph is to click anywhere in
the paragraph and then press Cmd-Shift-T.

When you display the Tab Ruler, the entire paragraph that contains the
insertion point is automatically selected. This reminds you that changes to
the Tab Ruler affect entire paragraphs.
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Tab settings affect one paragraph or a series of paragraphs.

If you like, you can use Select All to have Tab settings on a single ruler affect
all text. A paragraph, however, is the smallest unit that the Tab Ruler
controls. If you want different Tab settings on a line-by-line basis, place a
Return at the end of each line to form separate paragraphs.

The units on the Tab Ruler are determined by your choice of horizontal
ruler units in the General Preferences dialog box. Inches are shown below. If
you choose picas for units, picas are displayed on the ruler.

Tab Ruler Terminology
The first line indent marker is the small triangle at the top left of the ruler.
The default setting is zero. To set a first line indent for a paragraph, drag the
marker to the right.

The left indent marker is the small triangle below the first line indent
marker at the left of the ruler. It controls the indentation for all lines except
the first line in every paragraph. As with other markers, drag it to change
indentation. Its default setting is also zero.

The right indent marker is the triangle at the right of the ruler. It controls
right indentation of all lines in the paragraph (or paragraphs, if more than
one is selected). Drag to set an indentation. The default setting for right
indent is snug against the right side of the text block.

Choosing Tab Ruler and dragging markers on the Tab Ruler is one way to
set indentation.

Another way to set indentation is with the Paragraph dialog box. Choosing
Paragraph from the Text menu selects the paragraph(s) where the insertion
point is located. You set indentation by entering values in the First, Left, and
Right fields.
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If you prefer to use the Paragraph dialog box to set indents, you might also
use the Apply button to check out the effect of your settings before
confirming the changes with OK.

Setting a Tab stop
To set a Tab stop at the location of your choice:

1. Move the pointer over the bottom half of the Tab Ruler. The pointer
changes to an arrow.

2. Click on the Tab Ruler to set a Tab stop.

You will always start by creating left tabs, as a left tab is the default. We’ll
get to changing Tab types in a minute.

Notice that tabbed text now moves over to line up with the Tab stop on the
ruler. Notice also that the pointer changes to a hand when it’s over a Tab stop
on the ruler. This is to indicate that you can move the Tab stop by dragging it.

Note:  When setting or moving a Tab stop, the tab’s precise location is
displayed in the Status Area.

Default Tabs
Is it necessary to set tabs on a Tab Ruler? Can’t you just press the Tab key to
put tabs in text?

Not if you actually want to align text. Without a Tab stop to align to, a tab
character just makes a space 8 points wide.

Removing a Tab stop
To remove a Tab stop, just click and drag it off the Tab Ruler and release the
mouse.
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Moving a Tab stop
To move a Tab stop, position the pointer on the Tab stop, and when the
pointer becomes a pinching hand, drag the stop to a new location.

Changing the Tab type
1. Double-click on a Tab stop.

2. Select a Tab type in the resulting dialog box and, optionally, a Tab leader
character.

Left tabs
Similar to the familiar typewriter tab, Left tabs are the default since they
are the most frequently used.

Tabbed text is placed flush left against a left Tab marker.

Right tabs
Right tabs require either a return at the end of the tabbed line or another
tab at the end of a tabbed item. The first character defines the start of the
text that’s being moved. The second character (Return or tab) determines
the end of the text that is being made flush right.
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Center tabs
Center tabs, like right tabs, also require either a return at the end of the
tabbed line or another tab.

The first character defines the start of the text that’s being moved. The
second character (Return or tab) determines where the text will center.

Decimal tabs
Choose a Decimal tab when you want the decimal point in numbers to
line up vertically or when you want to line up your text by a character
that you specify in the field next to the Decimal tab type.

The Decimal tab requires a tab character in the text and also a period,
which determines where the text aligns. In most cases, the period will be a
decimal point in a number, hence the name of the tab.

Left Tabs Decimal Tabs
Tomatoes $2.99
Stereos $475.00
Ferraris $98,750.00

Tomatoes $2.99
Stereos $475.00
Ferraris $98,750.00

For example, the text on the price listing on the left uses a standard Left
tab, while the listing on the right shows the benefit of a Decimal tab.

With Decimal tabs, the first delimiter is the Tab character and the second
delimiter is usually the decimal point (period). However, Decimal tabs
can be made to align to any character. You simply enter the different
character into the field next to the word “Decimal:” in the Tab Settings
dialog box.
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Tab Leaders
Tab leaders, dots in most cases, lead to the text at the next Tab stop. Creator
assumes a blank Tab leader unless otherwise specified.

When you want to add Tab leaders to text which already has tabs set,
double-click the Tab stop and the Tab Settings dialog box appears. Then,
you select a Tab leader, click OK, and a row of characters (according to your
choice) appears in the tabbed space.

Custom Tab leaders
Because Tab leaders are characters in Creator, they can be altered just like
other characters.

Some other possibilities include the following:

• Super, Sub or other Offset leader characters.

• Leaders in different fonts and sizes, such as Zapf Dingbats.

• Horizontally scaled or kerned leaders.
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PREFERENCES

There’s quite a bit happening beneath Creator’s surface.

When you first use Creator, you’ll use Creator’s default settings. However,
you will eventually want to customize your copy of Creator so it works
the way you like.

For example, not everyone works in inches. Using Creator’s Preferences,
you can tell Creator to use picas instead. Most of these Preference settings
are stored in your Creator folder in a file named “Creator 4.0 Prefs.”

Global and Ad-Specific Preferences
Here’s an important distinction. Creator stores two types of Preferences:
settings that are in force for only the active ad and settings that apply to every
ad.

Preferences that apply only to the active ad are found in the Formatting
Rules dialog box in the Ad menu:
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Global settings—those affect every new ad you create—are determined by
your choices in the Preferences dialog boxes, which are found through the
Preferences submenu under the Edit menu.

For more information regarding the options in the submenu, refer to the
Creator Reference Manual section on the Preferences dialog boxes.

The “Creator 4.0 Prefs” file contains global preference settings and is found
in the same folder with the Creator application or in the Creator Add-ons
folder. The Creator 4.0 Prefs file records the settings specified in the
Preferences dialog boxes as well as the following information:

• ad sizes

• default font, size, and style settings

• custom text styles

• other program settings

You can have one or many Preferences files (named anything you like).
To open a Preferences file to apply its settings to the current work session

1. Choose Open from the Preferences submenu under the Edit menu.

2. In the dialog box, double-click on the Preferences file to be opened.

To save a Preferences file
1. Choose Save from the Preferences submenu under the Edit menu.

2. In the subsequent dialog box, specify a name and location for the
Preferences file to be saved and click Save.
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MULTIPLE LAYOUTS

Creating ads means creating layouts.

With Creator, you can create as many layouts as you wish. Multiple layouts
is a powerful and useful feature; you can create multiple layouts to test
ideas, try different formatting or effects, or display for yourself or others
many ad choices at once.

In general, layouts may differ in size of objects, color of objects, location of
objects, and text formatting and attributes.

In other words, you can resize, position, and format differently in each
layout.

The Layouts dialog box is one way to move between layouts, show all
layouts, create, rename, or delete layouts. Another way to show all layouts
is to choose All Layouts from the View menu.

If you like, layouts can differ greatly. Each layout can have a unique format.
And objects in one layout may not be included in other layouts. (If they are
not included, they’ll be shown off to the side in the Desk Area when
viewing that specific layout.)
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Objects In Layouts
To make multiple layouts powerful while avoiding confusion, we had to
answer questions like, “If I create or delete something in one layout, what
happens in other layouts?” And, “If I change something, is it changed
everywhere?”

Here’s how it works: When you create anything (including text), it is created
in all layouts.

If you have more than one layout, the object is created in each layout
automatically, but shown off to the side in all layouts except the layout
you’re presently in.

Since text blocks are also objects, when you create text (by typing in a text
block or by importing text), the text is created and placed in the same spot
in all layouts.

What can differ?

What about changing the characteristics of objects? Which characteristics
may vary among layouts and which can’t?

The answer to “What can vary?” is “Pretty much everything.” Some of the
characteristics that can differ in different layouts include the following:

• object size
• object position
• object frame weight
• object frame pattern (or gray or color)
• object fill pattern (or gray or color)
• object rotation and attributes
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The easiest way to see what can differ between layouts is to look at the
Same in All dialog box, where you control which attributes will be identical
in all layouts without going to each individual layout to set the attributes
manually. (Same in All is dimmed if only one layout exists.)

Use New Layout on the Ad menu to make a new layout.

Select an object, then choose Same in All from the Objects menu.

If you create an oval, set the frame weight and fill color, and then decide
you want the oval to be the same in all layouts, choose Same in All, and
check Line and Fill.

What can’t change between layouts? Only the actual object itself. A
rectangle remains a rectangle in all layouts; its size and position (or most
any other characteristic) can change, but it can’t be a rectangle in one layout
and an oval in another. The object’s basic shape stays the same. This
includes shapes of polygons and the number and depth of starburst points.
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Cut, Copy,
Paste, And Clear

Editing operations can act on the active layout or all layouts, depending on
whichever you prefer. You can have Cut, Copy, Paste, and Clear work in all
layouts at once or only in the active layout.

The default is for edit actions to work in all layouts. If you’d rather have
editing actions affect only the active layout, deselect the Edit in All Layouts
option in the General Preferences dialog box, found in the Preferences
submenu under the Edit menu.

If you go with the default, Edit in All Layouts, we suggest also checking
Confirm Edits in the General preferences dialog box. This presents a dialog
box when you Cut, Copy, Paste, or Clear. The dialog box lets you confirm or
cancel the edit and specify whether you want the edit to affect the active
layout or all layouts.

Confirm Edits is a handy way to edit in one or all layouts on an action-by-
action basis. You might want one Clear to affect all layouts, and the next
Clear to only affect the active layout. With Confirm Edits checked, you can
edit with more precision.

Text In Layouts
The “What stays the same? What’s different?” questions are easy to answer
for text in layouts. The actual text is the same in each layout. Everything else
can differ. So each layout can have a unique font, size, style, position,
number of text blocks, paragraph formatting, kerning, horizontal scale, text
gray or color—you name it! Only the actual characters can’t vary between
layouts.
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THE COLORS PALETTE

With the Colors palette, you can set a color for an object’s fill (inside) or
frame (outline). You can also set a gradient and a shade to a color. (We’ll
just say “color” from now on.)

Frame

Fill Gradient Shade

Note: Colors can also be assigned to objects from each object’s Object dialog
box, which you open by double-clicking on the object. Please see
Chapter 3 of the Reference Manual for more information.

Like the Tools palette, the Colors palette can be shown or hidden. To hide
the Colors palette, press Ctrl-Tab or select Colors from the View menu.
(Ctrl-Tab also makes the palette appear, if hidden.)

The color list in the Colors palette is saved in your ad file. If you add colors
to the color list and want to be able to share them with other users, you can
save the color list as an independent color file from the Define Colors dialog
box. You can then give fellow users the custom colors in your Creator
Colors palette by giving them a copy of the saved color file instead of a copy
of the entire Creator ad.
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Creator is smart about colors. If, for example, a colored object is on the
Clipboard but the colors in the object aren’t in your Colors palette, the object’s
colors are automatically added to the color list when you paste the object into
Creator. Thus, you can swap Scrapbooks, for instance, with someone else and
they’ll receive the colors necessary to recreate your work.

Spot colors from placed EPS graphics can also be added to the active ad’s
Colors palette. They can be added automatically by checking the “Copy
spot colors to palette” option in General Preferences, or you can add them
on a file-by-file basis from each placed EPS graphic’s Object dialog box. You
can also tell Creator to print the spot colors from placed EPS graphics as
process colors by selecting the “Print spots as process” option in each Object
dialog box or selecting the “Treat spots as process” option in the General
Preferences dialog box.

In the dialog boxes to set Grays, RGB, and CMYK colors, you can enter
numbers in the text fields or use the arrows to increase or decrease the
values in the fields. To help in “arrowing” a long way (from 1% to 80%, for
example), the speed increases the longer the arrow is pressed. To slow
down, let up for a second and repress the arrow key.

Colors Palette Controls
The four icons at the top of the Colors palette represent from left to right:
Frame, Fill, Gradient, and Shade.

One is always selected. For instance, if you want to assign color to the frame of
one or more objects, you select the objects, then make sure the frame icon (the
first icon at the top of the palette) is chosen, and then click on your color choice
in the list below. (A single click is all that’s required.) The palette comes with
preset colors, so for more information on setting the colors in the Colors palette,
see the section on the Default Colors List in the Reference Manual.
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 Gradient Fill
Any object drawn in Creator (including squares, circles, polygons, freehand
shapes, and starbursts) can be filled with a gradient.

Double-clicking on a shape shows that shape’s Object dialog box. Within
that dialog box, there is a Gradient button.

Clicking the button brings up the Gradient Fill dialog box.

To apply a gradient fill to a shape using the Gradient Fill dialog box:

1. Select the Type of gradient. The Type icons provide a miniature preview
of each gradient type’s effect.

2. Select the Start and End colors from the respective pop-up menus. Any
color that appears in your Colors palette appears in these pop-up menus.

3. Click OK to return to your shape’s Object dialog box. Click OK in the
Object dialog box to return to your Ad Window.

You can also access a selected shape’s Gradient Fill dialog box by double-
clicking on the Gradient icon in the Colors palette.

For a more detailed look at using the Gradient Fill dialog box, please refer to
that section of the Creator Reference Manual.
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Manipulating Colors
To add or change colors, either choose Define Colors from the Ad menu or
double-click on a color in the list of colors in your palette to display the
following dialog box:

Adding a color
1. Use the pop-up menu to select a color model. (This is the first instruction

because it’s important that you select a model before clicking New.)

2. Click New.

3. In the dialog box that appears, create or specify the new color and enter
a name for it in the Name field. Or, you could also accept the color’s
description as its name. Please note that not all color model dialog boxes
have a field for naming a new color, but you can use the Rename button
to change those colors’ names.

4. Click OK to exit the New dialog box and return to the Define Colors
dialog box.

5. Click OK to add the color to the Colors palette.

The new color appears at the bottom of the scrolling colors list in the Colors
palette.
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Making a color a spot color
1. Choose Define Colors from the Ad menu or double-click on a color in

the Colors palette to display the Define Colors dialog box.

2. In the list of colors, highlight the color you want to change to a spot color.

3. Select the Spot button. Click OK.
Note: Spot colors are shown in italic in the Colors palette.

Editing an existing color
1. In the Define Colors dialog box, select a color model using the

pop-up menu.

2. In the list of colors, click on the color you would like to edit.

3. Click Edit.

4. Edit the color in the dialog box that appears. Change the color name if
you wish by entering a new name in the Name field, if available.

5. Click OK to exit the dialog box and return to the Define Colors dialog
box.

6. Click OK. The color is modified in the Colors palette. If you changed the
color’s name, the name will be modified in the scrolling colors list in
your Colors palette.

Copying a color
1. In the Define Colors dialog box, select the color (in the colors list) you

would like to copy.

2. Click Copy. A copy of the color is added to the colors list. Rename the
color by selecting it and clicking on the Rename button.

3. Click OK to exit the Define Colors dialog box and add the color to your
Colors palette.
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Deleting a color
1. In the Define Colors dialog box, select the color (in the colors list) you

would like to delete.

2. Click Delete.

3. Click OK.

4. The color is removed from the scrolling colors list in your Colors palette.

Renaming a color
1. In the Define Colors dialog box, select the color (in the colors list) you

would like to rename.

2. Click Rename.

3. In the subsequent dialog box, rename the color and click OK.

4. Click OK to exit the Define Colors dialog box and make the change in
the ad’s Colors palette.
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Adding spot colors from a placed EPS file
When you place an EPS file containing spot colors into your ad, you
can copy the spot colors to the ad’s Color list. This can be done
automatically for all placed EPS files if the “Copy spot colors to ad” option
is selected in the General Preferences dialog box. Or, it can be done on a file-
by-file basis from each placed EPS file’s Object dialog box.

1. Double-click on the placed EPS file. The following dialog box is 
displayed:

2. Click the Spot Colors button to bring up this dialog box:

 

3. Select the colors you want to add to the color list and click the “Copy to 
Ad colors” button. Click OK when finished or click Cancel to leave the 
dialog box without making any changes.
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Adding colors from a previously saved color file
1. Click Open in the Define Colors dialog box to display the following 

dialog box, which allows you to add colors from other Creator ads or 
saved color files to your active ad’s Colors palette.

2. Locate and highlight the color file that contains the colors you want 
and double-click it. Or, you can click Open. Any colors contained in 
the color file that are not in your active ad’s Colors palette are 
immediately added to it.

If you have more than one ad file open, remember that the colors are added
to the ad in the active (topmost) window only.

To save a color file
1. Click Save to display the following dialog box, which allows you to 

name and save the color list of your current ad as an independent 
color file to be merged into future ads.
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While the color list is still saved automatically as part of the ad, the independent
color file you create with this feature can be transferred into future ads (see
Open, above), so you don’t have to keep the original ad file around in order to
keep the color list. You can share this color file with other users.

Rearranging the Colors palette
Hold down the Command key and drag a color to a new location on the
Colors palette.

Note:  The first four items–—None, Black, White, and Registration—are
defaults and can’t be moved from their location on the Colors palette.

Assigning colors to imported graphics
You can assign any color on the Colors palette to some imported graphics.
To color an imported graphic, select it and click the desired color on the
Colors palette. A second way of assigning a color to an imported graphic is
to double-click on the imported graphic and choose the appropriate color
from the Color option in its Object dialog box.

• A single color can be assigned to some EPS images.

• A foreground and background color can be assigned to MacPaint
images, black-and-white TIFF or GIF images, and some PICT
images.

Please see Chapter 3 of the Reference Manual for more information on the
color options available for specific graphics types.
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THE STYLES PALETTE

The Styles palette controls three types of Styles:

• Type Styles

• Paragraph Styles

• Style Models

Type
Styles

Paragraph Styles Style Models

The Styles palette can also display keyboard shortcuts that you assign to
each Style.

To select a Style type
Click the icon associated with that Style type in the Styles palette.

Each type of Style controls a certain aspect of formatting text.

• Type Styles control the formatting of the text characters: font, size,
leading, and other character attributes.

• Paragraph Styles control the paragraph information: margins, tabs,
hyphenation, quad leaders, and other paragraph settings. A Paragraph
Style may also apply a Type Style.

• Style Models are used to apply sequences of character formats and
paragraph formats to text. A Style Model may also apply both Type
Styles and Paragraph Styles.
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To apply a style
1. Click one of the icons at the top of the palette to choose between Type,

Paragraph, or Style Models.

2. Select the text you wish to style.

3. Click on the name of the style to apply it.

The location of a style on the Styles palette can be changed by holding down
the Command key and dragging the style to a new location.

THE FILES PALETTE

The Files palette is a convenience for creating documents with many
imported graphics or text files. It allows you to make a reference list of files
to place.

Files to be placed

Place dialog button

Remove from list button

To the left of the file names are symbols to denote the type of file. In the
illustration above, the first file is a TIFF, the second is a GIF, the third is a
PICT, and the last is an EPS file. Other file types include bitmap files and
text files. A check (�) by a file indicates the graphic has been placed in the
ad.

You use the Place and Import Text dialog boxes to add files to the Files
palette. In the dialog boxes, you select a file you’d like to add to the palette
and then click the “Add to list” button.  In the Place dialog box, you can
click the “Add all” button to add all of the current directory’s files, as listed
in the scrolling list, to the Files palette.
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When you’ve finished adding files to the list, click Done and the Files
palette is updated with the file names you’ve chosen.

To place a graphics file using the Files palette
1. Click on a file name to select it.

2. Then, click on an area of your ad to set the top left corner of the file.

OR

Drag a rectangle for the file to appear in.

After you’ve placed a file, the file name is marked with a check in the Files
palette.

Double-clicking on a file name
What happens when you double-click on a file name depends on the type of
file.

• If you double-click on a MacPaint file, it is placed in the Paint
Window.

• If you double-click on any other type of graphic file, it is automatically
placed in the center of the ad.

• If you double-click a text file, the Break Text dialog box is displayed,
and you can break the text file into individual blocks.
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Using the buttons on the Files palette
The top of the Files palette contains two buttons:

Place dialog button

Remove from list button

The Place dialog button opens the Place dialog box when you are in Object
mode and the Import Text dialog box when you are in Text mode. Clicking
the trash can button removes a selected file from the palette. You can
remove all the files in the palette by pressing the Option key while clicking
the trash can button.

Using Multi-Ad Search® with the Files palette
If you have Multi-Ad Search and you’ve copied file references in Search,
here’s a feature you’ll find handy:

Hold down the Option key and click on the Place dialog button in the Files
palette. This adds the files you’ve found in Search to the palette.

For more details on using Creator with Search, please refer to that section in
the Creator Reference Manual.
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Attributes
ad border 5

A character 98
new text blocks 56Actual Size view 5 paragraph 61, 98Ad Area 4
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files 33 Borders

Ad layout, see Layouts creating in an ad 33
Ad resize handle 5 files 33
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saving a color list 89 Delimiters 74
spot colors 90 Desk Area 5, 17, 85

designating  93 Desktop color separations 43
Colors palette 89-97 Dragging objects 37

description of 89 Drawing tools 16
icons in 90 Drawing, see Creating
rearranging 97

Commands palette 14
Confirm edits option 88 EConstraining movement 37 Edit in all layouts option 88Copy 88 Enlarge 51Copy Char Specs 59 EPS effects tool 32Copy spot colors from EPS option 90 EPS effects, creating 32Copy ¶ Specs 63 EPS files 21, 38, 45Corner roundness 25 adding colors to colors list 95Creating assigning color to 97ad borders 33 copy spot colors from 90borders in ads 34 export as 42-45circles 25 ExportEPS effects 32 as CIF file 47freehand lines and shapes 28 as EPS 42-45lines 26 as GIF file 48ovals 25 as text file 46Paragraph Style 63 as TIFF file 49polygons, irregular 27 Export Color option 48, 49polygons, regular 31 Export Resolution option 49rectangles 24 Export Size option 48squares 24 Faxing ads 45starbursts 29

stars 31
Style Models 67
text and text blocks 19, 55
Type Styles 59

Creator
keyboard shortcuts 8
menu bars 6
object menus 7
text menus 8

Cropping tool 21
Cut 88

F
File types, placeable 38

D Files palette 72, 99-101
icons 101Decimal tab 81 using Multi-Ad Search 101Default settings Fill icon 90paragraphs 60 Fit in Window 5, 12tabs 79 Font styles 57text 56 Formatting Rules 83text font and size 73 Formatting textDefine colors dialog box 90
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character Hyphenation 60
copy char specs 59 Importing text, see Placing
paste char specs 59 Indent markers, see Tab Ruler
with Type Style 59 Indents, see Tab Ruler

paragraph Interlace 48
copy ¶ specs 63 Invisibles 67, 77
defaults 60 Irregular Polygon tool 27
paste ¶ specs 63 Irregular polygons, drawing 27
with paragraph style 63-64 JPEG files 21, 38

tabs, see Tab Ruler Keyboard shortcuts 8, 98
with Style Models 67-70

Frame icon 90
Freehand shapes, drawing L

Lasso tool 51
Layouts 85G confirm edits 88

General preferences, see Preferences consistency among 87
GIF files 21, 38 edit in all 88

assigning color to 97 multiple 85
exporting as 48 new 87

Global preferences, see Preferences objects in 86
Gradient Fill, see Gradients same in all 87
Gradient icon 90 text 88
Gradients 91 variations among 86, 88

applying to object 91 view all 85
types 91 Leaders, see Tab Ruler

Graphics Level 2 PostScript option 44
assigning colors to 97 Limit resolution to option 44
cropping 21 Line tool 26
enlarging 51 Line weight 26
file types for placing 38 Lines
in general 38 drawing 26
placing 39 line weight 26

drag and drop from Finder 40 object dialog box 26
drag and drop with Search 41
Paint Window 50 M-Nusing the Files palette 100 MacPaint files 21, 39, 50

assigning color to 97Graphics, placing, continued
Make Matrix 75-76with cursor 40
Make Style Model 68without options 39
Make Type Style 59reducing 51
Make ¶ Style 61, 63Guide Snap Toggle 11
Measurement units 78Guides
Menu bars 6setting 11
Microsoft Word 71viewing 11
Movement, constraining 37
Moving objects 17, 37
Multi-Ad Search 41, 47, 101H-K

Hand tool 50
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O creating 63-64
using with Type Style 65-66Object mode Paste Char Specs 59defined 7 Paste ¶ Specs 63menus available 7 Percent view 5Objects PICT files 21, 38borders 33 Pinching fingers 36defined 15, 38 Place with cursor option 40, 71dialog boxes of 15, 17, 24 Placingdragging 37 graphics 39-40drawing 16 drag and drop from Finder 40drawn on and off the ad 36 drag and drop with Search 41in multiple layouts 86 Paint Window 50lines 26 types 38manipulating 15 using the Files palette 100moving 17, 37 with cursor 40placing 11 without options 39resizing 9, 17, 36 text 71rotating 22 into a text block 71selecting 17, 36 types for placing 71smoothing 28 using the Files palette 72, 99Offset leader 82 with cursor 71OPI options 45 with no options selected 72Ovals, drawing 25 Plate separations 43

Polygons
irregular 27P-Q closed 27

open 27Page Setup 36
Object dialog box 28Paint Window 39, 50-51
regular 31copying from 51
smoothing 27placing from 50

PostScript fonts 57selecting in 51
PostScript Level 2 option 44
PreferencesPalettes

ad-specific 83colors, see Colors palette
generalfile, see Files palette

“confirm edits” option 88Paint Window 50
“edit in all layouts” option 88style, see Styles palette
copy spot colors from EPS option 90tools, see Tools palette

global 84Paragraph
opening and applying 84alignment 60
saving 84attributes 61, 98
submenu 84defaults 60

global vs. ad-specific 83dialog box 78
text preferencesformatting

new block defaults 56copy ¶ specs 63
paragraph defaults 60paragraph style 63

Preview types 43paste ¶ specs 63
Printing 4, 44tabs, see Tab Ruler

Paragraph Style 63, 64, 98
Rbased-on pop-up menu 66
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Random option, see Starbursts line weight 26
Rectangle tool 24 ruler zero points 12
Rectangles Setup Guides 11

creating 24 Shade icon 90
setting corner roundness 25 Shortcuts 20

Reduce 51 keyboard 8
Renaming a color 94 tab ruler 77
Reshape command 30 Smooth command 27
Resizing Spot colors

ads 5 adding to colors list 95
objects 9, 17, 36 adding to palette 90
proportionally 36 designating 93
text blocks 20, 52 Squares, drawing 24
windows 12 Standard character styles 57

Resolution Standard delimiters 74
limiting in EPS files 44 Starburst tool 29, 31
of exported TIFF file 49 Starbursts 29

Return characters 62 customizing 31
RIFF files 21, 38 dialog box 29
Rotating drawing 29

with the Rotate tool 22 drawing limitations 30
with the Rotation dialog box 22 point options 30

RTF files 71 random points 30
Rulers 10 reshaping 30

setting guides 11 Stars, drawing 31
setting units 10 Status Area 9, 75
setting zero points 12 Status labels 9
viewing 10 Style Models 56, 67, 98

S creating and using 67-70
defined 67Same in All 87 Style types, selecting 98SAU sizes 2 Styles palette 60, 64, 98-99Save ad preview option 47 Styles, applying 99Scaling Switching between text, object mode 19graphics 40

text 52
Scrapbook 50 TScroll bars 13
Selecting Tab key selection 18

methods 17 Tab leaders, see Tab Ruler
multiple text blocks 54 Tab Ruler 67, 77-82
objects 17, 36 indent markers 78
selection marquee 50 setting indentation 78
style types 98 tab leaders 64, 82
text 54, 73 customizing 82
using the Tab key 18 setting 82

Selection handles 36 tab marker 77
Selection marquee 50 tab settings 78
Setting tab stop 77

ad size 2 moving 80
corner roundness 25 removing 79
guides 11 setting 79
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tab type 80 widgets 53
center tabs 81 Text file, export as 46
decimal tabs 81 Text mode
left tabs 80 defined 8
right tabs 80 menus available 8

tabs Text Only files 71, 73
default settings 79 Text tool 16, 19-20, 71
show 77 capabilities 19

Tab settings, see Tab Ruler shortcuts 20
Tab stop, see Tab Ruler TIFF files 21, 38, 45
Text assigning color to 97

breaking 74-76 exporting as 49
delimiters 74 Title bar 5
into existing text blocks 75 TMAU Sizes 3

character styles 57 Tools palette 16
complex character formats 58 arrow tool 16
creating 19, 55 border tool 34
defaults 56 cropping tool 21
editing 19 drawing tools 16
flowing 20, 53 EPS effects tool 32

Tools palette, continued
irregular polygon tool 27

Text, continued rectangle tool 24
formatting 52, 56 rotate tool 22

copy char specs 59 starburst tool 29
paste char specs 59 text tool 16, 19
with Paragraph Style 63-64 viewing 15
with Style Models 67-70 Type Style 98
with Type Style 59-60 based-on pop-up menu 66

importing 71-76 creating 59-60
into a text block 71 using 60
types for placing 71 using with Paragraph Style 65-66
using the Files palette 72, 99
with cursor 71
with no options selected 72 U-Zin multiple layouts 88 Units of measurement 78leading 52 Viewlinking 53 actual size 5preferences 56 all layouts 85scaling 52 fit in window 5selecting 54, 73 percent view 5sizes 52 Widgetstyling/formatting 56 end 53Text blocks more 53considered objects 24 World Wide Web 48creating 19, 20, 55 WriteNow™ 71defined 53 Zero points, setting 12flowing 20, 54 Zoom box 12linking 53

object dialog box 53
resizing 20
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